1 Xestidon de proxectos en Eclipse
1.1 Sumario
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e 2 Crear un proxecto
e 3 Cambiar de workspace
¢ 4 Organizacion de proxectos dentro dun workspace: Working Sets
¢ 5 Importar proxectos
* 6 Proxectos féra do Workspace
¢ 7 Borrado de proxectos
* 8 Preferencias: workspaces

1.2 Introducién

¢ Antes de enfrascarse na creacion de proxectos, imos ver como xestionalos en Eclipse.
¢ Imos ver como importalos e as opciéns existentes.

« E bo botarlle unha ollada ao seguinte material, para evitarse sorpresas desagradables coa perda de proxectos.
e Como xa se indicou recoméndase a lectura do seguinte documento: "Mi primera hora con Eclipse™:
http://ubuntulife.files.wordpress.com/2008/03/intro_eclipse_espanol.pdf

1.2.1 Iniciar Eclipse

e Como xa se viu na Unidade 1, imos comezar abrindo o Eclipse como se fose a primeira vez.
¢ Escolleremos a perspectiva de Java.

¢ O Workspace ¢ o lugar onde Eclipse almacena por defecto os proxectos e informacion sobre estes nunha carpeta chamada .metadata, que
pode traer algunha que outra complicacion.

¢ |niciar Eclipse

° - lr-'r.-rh'-_:par_.\! Launcher
Select a workspace

Eclipse stores your prajects ina felder called a workapace,
Choose a workspace Folder ba use For this session

(UE L ETET o me/ladmin/workspace Browse. ..

Wse this as the default and do nat ask again

Canced QK

Escoller se se desexa que pregunte polo directorio do Workspace a proxima vez que se inicie.
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Escoller a perspectiva Java.

1.3 Crear un proxecto

¢ Un usuario pode ter varios Workspaces ou outros cartafoles para organizar os seus proxectos. Asi, pode ter proxectos de distintas materias
ou distintas linguaxes en distintos Workspaces.

* Un proxecto pddese crear no cartafol do workspace ou noutra calquera. En calquera caso, almacenarase informacién sobre os proxectos no
cartafol .metadatos do Workspace co que se estea a traballar.

¢ Agora imos traballar con proxectos lixo para estudar as distintas opciéns, logo mais en diante explicarase os campos dos cadros de didlogo.

e Estes proxectos borrarémolos ao finalizar este apartado.

¢ Crear un proxecto lixo


https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_02.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_03.jpg

Open File...

Project...

Package

Class

inberface

Eniim
Annotation
Source Folder
Java working Set

Folder
Refresh : I File
Convert Line Delimiters To L unkitled Text File

Androkd XML File

Binik Weeb S

Creamos un novo proxecto de Android.

Haw Ardrold Apghcation
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i b Cancel

Indicamos nome da aplicacion: Proxecto1.
OLLO! Edicién 2015: Indicar como SDK minimo API 16.

Hew Ardrold Application
Configune Project

B Create custom launcher ion

B Create actisity
Miark this praject as a library

B creabe Project inwarkspace

working sets

Add praject o working sets

¥ <Back [ NERER ] Cancel

Observar que o proxecto vaise crear dentro do Workspace.
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Indicamos o0 nome da actividade: Proxecto1l.
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package com.example.proxectol;

public class Proxectol extends Activwity

Mverrids
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supar, onl reate(savedIns tanceStat]
setContentWiew(R, Layout . activity

@O

public bBoolean onCreat=0pticnsMenu(M
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E na carpeta correspondente ao Workspace.
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Contido do cartafol Proxecto1. Coincide co contido do Proxecto1 do IDE.

Rede

1.4 Cambiar de workspace

e Crear mais proxectos lixo

. afe Launcher

Select a workspace

Eclipse stones your projects ina folder called a workspace.
Chaase a workspace Falder to use For Ehis session

workspace: E,fh:-mr,.'l.-m Wil kspacesd " Browse...

5

Use this as the defaulk and do not ask again

Cancel 2.4

Pechamos e abrimos Eclipse, indicamos un novo Workspace para outros proxectos: workspaces2.
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Premendo en File->Switch Workspace podemos cambiar de Workspace ou ver os dispoiiibles, premendo en Other. Neste menu € onde se
pode cambiar de workspace, cando na pantalla de inicio non temos habilitada a opcién de escoller.

Workspade Leuncher

Select a workspace

Eclipse stores yowr projects ina Folder called a workspace,
Choose a workspace folder to use for this sesslon.
waorkspace: | fhomefladminfwerkspacez ﬁ Browse.

fhomefladminfworkspacez

¢ Copy Setth Fhomefladmin/workspace

& cancel [

Tamén se pode pode engadir outro Workspace.

Workspace Launcher

Select a workspace

Eclipse stores youwr projects in a Folder called a workspace.,
Choose a workspace Folder bo use For this sesslon.

warkspace: |homefladmin/TEILEEIE - B GwSe. .
¢ Copy Settings G
i cancel [

Neste caso imos engadir o workspace3.

workspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace.
Choose a warkipace Molder bo e Mor thic sestion

Workspace; ,l'hnmelfl_a.dmln;mrt;pacej " Browse...
Mhomefladminfworkspacel
fhomefladminfworkspace? [}
fhomefladminfworkspace

Ui Lhis &% the delsult and do not ask again

Cancel QK
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Pechar Eclipse e volvelo abrir. Observar como agora ofrece os 3 workspaces.

wWorkspace Launcher

Select a workspace

Eclipse stores your projects in a folder called a workspace:
Choose a warkipace Molder bo uwme Por this session

Wi "k".p.'rr i |r| I‘!‘! 'I" i ; ;-:-;\gu :[-- ] ] L Browse..,
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Cancel QK.
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Pero como saber en que Workspace estamos?. Hai a posibilidade de indicalo na barra de titulo.
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B computador eclipse eclipae.ini b ep-viokiml
Rede - "

&R Explorar a rede —

lcanxpm noticn omil

E Conectarss 3 unse...

O ficheiro <ruta instalacion de eclipse>/eclipse.ini...

ladmin@ubase: ~
ladmin@ubase:~$ sudo gedit /fopt/eclipse/eclipse.int

... podemos editalo (A imaxe amosa como facelo en Linux. En Windows editar o ficheiro).
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Engadir ao principio: -showlocation.

o ¢ Java - Eclipse - fhomefladmin/workspace3
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Pechar Eclipse e volvelo abrir. Observar a ruta do espazo de traballo na barra de titulo.
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Aqui vemos os cartafois dos tres proxectos.

1.5 Organizacién de proxectos dentro dun workspace: Working Sets

¢ Xa vimos que se poden ter diferentes workspaces para que o usuario se organice como desexe.

* Pero dentro de cada Workspace, Eclipse, ofrece a posibilidade de organizar os proxectos en agrupamentos chamados: Working sets.

¢ En todo momento podemos mover proxectos dun Working set a outro, ter un proxecto en varios Working sets, decidir que Working sets
amosar/ocultar, etc.
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¢ Crear workingsets

Java - Eclipse - fhome fladmin/workspace3

File Edit R
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=
» 2 Proxecto3

» 3 Proxecto4

» = ProxectoJaval
No workspace3 crear 2 proxectos Android:

workipaoed

(Proxecto3 e Proxecto4) e un de Java (ProxectoJaval)

< oL
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‘E-;u:r: toria
4 Descargas ‘
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O contido do Workspace3.

Java EE - Eclipse - fhomefladmin/workspace3

Edit Run Window Hi

o Project Explorer 2| & 0O

24

» = Proxecto3
» = Proxectod

View Menu

F = ProxectoJaval

Na Vista de Exploracion de Proxectos premer no Menu da Vista (View Menu)
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Podemos crear Working Sets para agrupar, recursos, programas, etc. Neste caso imos escoller Java, pois son proxectos de Java (Android)
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Porfer un nome ao agrupamento: neste caso Java.
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... neste caso imos pasar o ProxectodJavail.
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... neste caso co nome Platega Android. Nesta ocasion, a modo de exemplo, non engadimos ningln proxecto.

Select a working set:
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Seleccionamos os 2 agrupamentos. Premer en OK.

lipse ™

B PackageExplor 2 = 0O

i Proxectal

Projects

Working Sels.

* i Proxechod

Select Working Set
* @ PromectoJava )

1 Window Waorking 5et
Filters. .

Package Presentation ¥

« Show 'Referenced Libraries’ Node

Link with Editor

No Menu da Vista, imos indicar que queremos ver os proxectos organizados por Working Sets.

Select and sort working sets wisible in Padcage Explarer
W 5 Cther Progects
5 sava
& 17 Platega Android
Select All
Deselack All
Sortworking sets
Few...
T Camncel oK, »

Podemos configurar que Workings Sets queremos configuar. Marcamos todos, entre eles: Other Projects. Tamén podemos indicar en que
orde desexamos ver os agrupamentos na Vista de Exploracion de Proxectos, para iso usaremos os boténs Up e Down.
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Java - Eclipse - fhomefladmin/workspace3
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‘& Other Projects
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» = Proxectod

* 15 Java
» = ProxectoJaval
15 Platega Android

No agrupamento Other Projects podemos ver que estan os proxectos que non se asignaron ao agrupamentos creados anteriormente.

® Jawva EE - Eclipse - fhome/ladminfworkspace3

& Project Explorer @ = O

— }_-* -

* 15 Java Top Level Elements "
* = ProxectoJaval

15 Platega Android dDeselect Working Set

Package Presentation k
Customize View..

Link with Editor

Premendo en Select Working Set podemos editar e crear novos agrupamentos.
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Asociamos os proxectos de Android a ese agrupamento. Observar como o ProxectoJaval, tamén se poderia asignar a este working set, de
modo que ese proxecto estaria en 2 agrupamentos.

- uing £

Sebect and sort working sets wisible in Package Explorer

& 75 Other Projects up
L lava
& P Platega Androdd
select all
Desetect AN
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Premer en OK.

Java - Eclipse - fhome fladminfworkspace3

ce Mavigate

[% Package Explor 2| = O

= s
5 other Projects Top Level Elements L
* 15 Java
* = ProxectoJaval §
* 45 platega Android Filters...
F = Proxecto3 Package Presentation ’
* 15 Proxectod + Show 'Referenced Libraries' Node

Link with Editor

Os proxectos organizados nos Working Sets. Indicar que no canto de todo o anterior poderiase ter arrastrado e soltado os proxectos dun
agrupamento a outro na presente pantalla. Volver a editar a configuracion ...

Configure Warking Sets

Sebect and sort working sets visible in Package Explorer:

= Other Projects up
LT
= & Plabega Android

Silect ALL
Deselect All
St working sets
Bl Ediit, Bemaoue
(i ] Cancel = h‘

Neste caso imos decidir que so queremos que se amosen 0s proxectos do agrupamento Platega Android.

I# PackageExplor 2| = 8

o
)

¥ 15 Platega Android
» =5 Proxecto3
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E ai o esta !l!

|2 Package Expler 2| = 0O

* & Prosectod
* 12 Proxectod
= = Proxectodaval

Warking Sets

Select Working Set..
Deselect Working Set

= 1 Window Werking Set
Filters...

Package Fresentation »
+ Show 'Referenced Libraries’ Node

Link with Editaor

Se queremos ver os proxectos independentemente de como estean agrupados, ... seguir o men( da imaxe.

% PackageExplor 2| = 0O

= 15 Other Projects
= Proxecto3
* o Proxectod

Projects

Configure Waorking Sets...

v i java Filbers...
* i Proxectolaval Packsge Presentation ¥
b Plabega Android " Show "Referenced Libraries' Hode

Lirk wikth Editor

Ou velos agrupados en agrupamentos.

1.6 Importar proxectos

¢ Os proxectos pédense levar dun equipo a outro simplemente copiando os cartafoles no que estan.
¢ Neste caso vanse copiar os proxectos contidos no Workspace3 a un novo cartafol chamado probas e logo importaranse.

e Importar proxectos


https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_52.jpg
https://manuais.iessanclemente.net/index.php/Archivo:Android_2013_U2_eclipse_53.jpg
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I Escritoio [ Escritaiis
+ Descarges ‘ & Descangas d
[ fwesusenitas Prowectod O Documentos P it
= R TT B imanes
o Mmica ‘ & Misica d
H videss Prowectoavat H videcs PT bt ava
E Lixo 'm'l_.:ln-
Disposltives ‘ Dlspesitivas r
M computadar nep"’:‘f:f’::ri-h B compatador
Hude Rede
SR Explorar arede ﬁE-p‘ﬂ:ara*cde
B conectarszawnse... E_ﬁ 0 Conectaivea unie,. Y
— = i —— T 1-'
G A rv———
Copiar os proxectos contidos en workspace3 a un cartafol chamado probas

W'

¢ Launchar

Select a workspace

Eclipse stores your projects in a falder called a workspace.
Choose a workspace Folder to use For this session

warkspace: | fhomefladmin/workspace -

fhomefladminfworkspace3

fhomefladminfworkspace2

Use this as the defaulk and do not ask again

Cancel

Browse.

oK

Pechar Eclipse e seleccionar o Workspace workspace.
Eclipse - /fhomefladmin/workspace

%

Navigate
CE BE vy gie
[# PackageExplore 8 = 0O
& proxecto1

Este xa contifia o Proxecto1. Observar como non estan os agrupamentos creado no workspace3.
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Mew Shiftvalt+d - rE

Qe File..,

Close all Shift+Coriatd

M.,

Renams...

Aefreih

Coavat Ling Delémiters To ¥

Swibch slarkspace ]
Restart

Expoet

Properties Al +Erie

1 Proxected java [Promectal s oamy.]
Z ackwity_proxectolaml [Promectoif...]

Enift

Premer en File -> Import

Select

Select an impert spurce:
i
¥ 2 Censral
& Archive File
= El.ii-[il"nj Pragects inba Warkspace
., Fille System
L Preferences
¥ = android
b= CfCe
* & CVS
F = BB
= R

Ll < Bach M Cancel i

Indicar que é un proxecto de Android.
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Import Projects
@ Select a directory to search for existing Android projects
Resel Direcbery: Browse... t}
Projects:
Project to Import Mew Project Mame celect all
Deselect All
Refresh

Copy projects into workspace
Warking sets

Add project bo working sets

i < Back e Cancel

Seleccionar o cartafol probas ...

# 4| @ladmin | probas

Lugares Nome

Q Buscar & Proxecto3

@ Usado recente... & Proxectod

& ladmin il ProxectoJava
@8 Escritorio Le

= Sistema de Fich...
i© Documentos

& Mdsica

m Imaxes

B videos

&S Descargas

... € automaticamente busca os proxectos que hai na carpeta probas e nas stas subcarpetas (ideal para corrixir proxectos). Observar que
non quere importar o proxecto de Java.
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Import Projects
Sebect a directory to search Por existing Androdd projects

Raok Directory: | fhomeflsdmin/probas
Projects:

Project b impart
& Prowecto3

B Proxectod

Mirw Project Name
|
| Promectod
| Proxectod

B Copy projects into workspace
Wirking sets [}

Add project b working sets

12 < Back

Cancel

©

Browie.—.

Select AN
Deselect Al

Refresh

Finish

Indicar que queremos que copie os proxectos do cartafol orixe ao workspace. Co cal se se modifican os proxectos, estes seran os que

estean no workspace e non no cartafol probas.

File

Edit

4 Package Explore &2

=]

L

- & proxectol
» == Proxecto3
» &2 Proxectod [}

Proxectos importados ...

1 Package Explore

Lugares
v Promecto | O Becentes
® 2 Prosecte " Cartal
o Proseched WEscrito...
e Descar...
O Docum..., Proxectol
G g
& ihissica ‘
Hvideas Praxsctad
1S Line
Dixpotitivay ‘
M comg...  RemoteSymtemsTe
mipFiles

Lugares
G He L es
™ Cartal
B Exortaria
& Descar...
[ Docum,
BY imaxes
o s
Hvidess
i Lima
Dspasitivar

B compu

Proxectodaval

R

E tamén copiados ao Workspace. Observar que proxectos estan/ou non en cada cartafol. A partir de agora co cartafol probas pddese

realizar o que se desexe.
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1.7 Proxectos féra do Workspace

» Nesta ocasién imos ver como ter proxectos féra do Workspace. Ainda asi este é necesario para conter o cartafol .metadatos que conten
informacién, entre outras cousas, sobre os proxectos.
* Obviamente, tamén se poden ter outros proxectos dentro do Workspace.

e Crear proxectos féra do WorkSpace

[ & Workspace Launcher

Salect a workspace

Eclipse stores your projects ina felder called 2 workspace,
Choose s workspace Folder to e For this session

workspace: [fhomefladmin/workspace? - Browse

fheme/ladminfworkspace
fhome/ladminfworkspace3

Use this as the default and do not ask again

cancel | (RO

Abrir de novo Eclipse no espazo de traballo workspace2.

Java - Eclipse - fhomefladmin/workspace2

Edit Refactor Source Nav * Search Projec

& PackageExplore 2| = 0O

> = Proxecto?

N

Contén no workspace o Procexto2 creado ao principio.

Java - Ecllpse - fhome fladminfworks

$1 Project...

Package

Class

Interface

Enum
Annatation
Source Folder
Java Working Set
Falder

File

untitled Text File
android XML File
JUnit Test Case
Task

Example...
Qther_.

Crear un novo proxecto de Android ...
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Appliation

Rew Androld Applicatisn
B The presfis 'com. example.’ (s meant a5 8 placelodder and should raot B used

Application Mames | Proxectas

Progect Hames® Proxectas

Package Hame s omexample pramcias

Minimum Requined SENCE 010 Androad 2, 2 (Fropa) i
Terget SCE-# AP 1B: Android 4.3 =
Comgile Withe® AP 1E: Androdd 4.3 -

Therme:® | Mola Light with Dark Actsan Bar =

¢ The apalication mame is shown s ithe Play Storce, 85 well 22 in the Menage Spplication
list in Setiergs

«.:;l!' + m il Carmd

Nome Proxecto5.
OLLO! Edicién 2015: Indicar como SDK minimo API 16.

Kew Amndrold Application
Coefigare Project

B Create custom lsunches icon

B Create activity
iehark s progect as a library

Create Project imWaorkspace

Locatior | fhomefadminfworkspaced Prapecial Broease...

b

working sets

Adsd progect bo working sets

"‘d.?' =lback &J Cancel

Na ruta indicar que se desexa crear noutro cartafol féra do workspace.
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Rew Androld Applicatisn
Coafigare Project

B Create custom launches icon

B Create actrty
fehari this project as alibrary

Creake Project imWorkspaoe
Lacation: | o Ladming ST TN T BanAsE...,

wWnirking sets

Add progect to working sety '

= Back Bl = LA

Ruta para o Proxecto5 féra do espazo de traballo.

Blank Activity
Creabes & nesvw blank actvity, with an action bar and optional nevigatianal elements such as
tabs or horizontal swipe

ALRIADY H drb s -_.-_-_' &b

Laynut Mames activily proeiias

Hadgation Tyee® Move

o Thakt fidarreis & I Ehii SeOENETY Clarks Lo CT Gl

X'

= Bach Caraal Hrhl h

Nome da actividade Proxecto5.

1 Package Explore | Lugares Lugares
= D ae ‘ A D Recerkes d
* W Proectal . . o N Cartaf [
* (& Prowectos [ Excritania
1] i
* B e o Descar d & Descar... &
¥ B coam.exampl [ Dacum FemaoteSysiemsaTe u Documn

F |7 Prowechas £ imanes mpFiles

o
o EImazes

Comparativa entre o IDE e os 2 cartafoles: o do workspace e o que conte? o proxecto5.

¢ Importar proxectos féra do Workspace
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Java - Eclipse - fhome fladmir

New shifteAlL+N: + F»
OpenFile.. |
I
Close all shiftsChri+w
Refrash F&

Comert Line Delimibers To

Swibch workspace
Restark

Expart.,. !

Importar de novo ...

Select "

Sefect an impart sowrce;

* 2 Gereral
¥ (& androld
® Existing Android Code Into Workspace

* 2= jnstall
* = A EE

* = Maven
B Db Miodsacdaurma ik

sl
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Proxectos de Android ...
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Impart Projects
Select @ directory to search far existing Androdd projects
Root Directory: | /homefladmin/probas B,
Projects:
Project bo Impart Mew Projeck Name Select All
Proxecod
1 Deselect all
& Proxectod | Proxectod
Refresh
Copy prajects ento workspace
Waking sets
Add project to working sets
'J = Back - Cancel | Finish

Pero ... esta vez non copiar os proxectos ao espazo de traballo. O resultado sera semellante ao anterior. S6 que agora os cambios que se
fagan nos proxectos 3 e 4 seran gardados no cartafol probas.

1 Sprkaie faply Lt Lugarea
= LN ‘ Q) Ewraisn ‘ D 2wy ‘
[ pam— " comal Prawscind A Cartaf Frame: Framic}
* i Preamctal e W Fuiatia .
L ‘ & b & Cwncargas d
¥ i ot D D OO LT O e, [t Priuiriod
- IR e B wnane Biimase
FTIren Bk ianicy —
e Hvidein Hidaza B i i R

Observar como se distriblen os 4 proxectos do IDE: 1 en workspace2, 1 no cartafol chamado 'proxectos_fora e 2 no cartafol probas

1.8 Borrado de proxectos

¢ Os proxectos pédense borrar dende Eclipse:
+ Pddese borra s6 o enlace no IDE, sen borrar os ficheiros do proxecto,
+ Ou tamén o cartafol que o contén os ficheiros do proxecto.
e Tamén se poden borrar os cartafoles directamente, pero teriase no IDE un enlace a un proxecto que non existe.

e Borrar proxectos

£ Java - Eclipse - fhome fladminfworkspace2
MHew
- GO Inka

Openin Mew Window
Open Type Hierarchy F4

¥ Package Expl Sho in SHIFL+AILLW o

Copy Chrl+t
- Copy Qualified Name
¥ == Proxecto? Paste Chrlavy
* = Proxectol TR
* = Proxectod | W

* = Proxectos

Build Path b
Source ShIFE+ALL+S o
Refactor NIFL+EAIL+T ¢
Borramos o Proxecto2.
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J 00 oskstetesowens
6 Are you sure pouwant to remove project "Proxecto?’ From the workspace?
Delete project contents ondisk (cannct be undone)

Project lecation:

fhame/ladmin/warkspaced/Prosecto?

P i = Cancel (a1

Pero non o borramos en disco.

Fouyrd prohlems

Mo ol infarmation sEilable

= Bach Cancil Conline

Unha advertencia ... Seguir...

workspace2

+ workspace2

'# Package Expl¢ Lugares
= O Recentes
*» = Proxecto3 M Cartaf...
» 2 Proxectod [ Escrito...
» & Proxectos w Descar... J
[ Docum... RemoteSystemsTe
(3 Imaxes mpFiles

Vemos que o IDE non ten o Proxecto2, pero este segue no cartafol workspace2.
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iy Go Into
Openin New Window
Open Type Hierarchy

- Pﬂfka Shﬂﬂln Shift+Alk
Copy

; Copy Qualified Name

PEPO pacte

[ '|..-_'—EI-F'TD ST
Delete

* = Pro k
Build Path
CANires ChiFkE g A

Borramos o Proxecto?2.

6 Are you sure youwant to remowe project 'PFroxectad’ from the workspace?

& Delete project conbents on disk (cannot be undone)

Fr%crr location:
fhome/ladmin/probas fProxectod

Preview s cancel | [EHE

Esta vez si 0 borramos no disco.

probas

probas
Lugares
@ Package Explorel -
& Recentes
3
= 3 M cCartafo... Proxecto4
F = Proxectod B Escritorio

F == Proxectos

|

0 bocum... FroxectoJaval

Nin no IDE nin no cartafol probas esta o Proxecto3.
1.9 Preferencias: workspaces

¢ Rematamos revisando onde se almacena a configuracion relativa aos workspaces anteriores.

* Preferencias
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Refresh
Corveert Lire Delimiters Ta '

Restart

Import

fMreameladmen/ workspaced
Hamefadmin/workspace

Cathaey,

Observar os espazos de traballo disponibles.

. fome fladminfworkspace2
i A S iginig -9
I Packageixplore B 7 O
-

b = Prosechod
* i Progectod

W

Mew wirdow

ke Toolbar

Open Perspeciive

Shuya Vigw '
Customize Perspective

Sawe Perspctive A5,

Besat Porg pective.

Close Perspective

Close Al Pers pecties

HMavigalian "
Ardirald S0E Manager

Aradraid vl Device Manages
B A ndrcsdd Lind '

Premer en Window -> Preferences.
(W ‘Workspaces

¥ Ceneral
F APQRATACE

B Prosmpt for workspace an stadun

Compase/Patch Aecent workspaces
Content Types
Edibors

Ky

fhomseladminfworkspace
Thisred Nadminwerks pace3

Mtk Connectice
Perspectives
Search

Security

sarvoe Paligies

Skartup and Shubdc
Workspaces

Tracing

inlgh Browses

a

Waorkspate

MHumber of recent workspaces to remember: 5

—

En General -> Startup and Shutdown -> Workspaces podemos eliminar a referencias aos espazos de traballo que se vifian usando até
agora. Tamén podemos configurar se queremos que siga preguntado/ou non, ao iniciar Eclipse, polos espazos de traballo.
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* Workspace

Deixamos s6 espazo de traballo workspace.

lava = Eclipse - fhome fladminfworkspacez

Open File_.

Refresh
Conmwert Line Delimibers To L

SwitchWorkspace v hamefladminfworkipace .

Restart Other...

Impart..
Agora xa s6 hai ese espazo de traballo.
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@ compat... [ workspace? | warkipace |

Rede

B Exploca d

# carialobe seleccionados |conbendo un

Para limpar todo imos borrar os cartafoles que usamos até agora, salvo ...
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-- Angel D. Fernandez Gonzalez e Carlos Carrién Alvarez -- (2015).
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